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Materi :
1. Sekilas tentang Delphi
2. Mengenal IDE Delphi
Maksud dan Tujuan :
1. Mengenal tentang pemrograman Delphi sebagai visual programming
2. Mengenal tipe file utama dalam project Delphi
3. Mengenal tipe data dalam Delphi.
4. Mengenal lingkungan kerja delphi

l. Sekilas tentang Delphi

Delphi adalah sebuah perangkat lunak (bahasa pemrograman) untuk
membuat program / aplikasi komputer berbasis windows. Delphi merupakan
bahasa pemograman berbasis objek, artinya semua komponen yang ada
merupakan objek-objek. Ciri sebuah objek adalah memiliki nama, properti dan
method/procedure. Delphi disebut juga visual programming artinya komponen-
komponen yang ada tidak hanya berupa teks (yang sebenarnya program kecil)
tetapi muncul berupa gambar-gambar. Dengan demikian delphi lebih mudah
digunakan dibandingkan dengan pascal, karena anda hanya tinggal mengatur
properti atau sifat dari objek dan menambahkan sedikit pengkodean.

Didalam delphi ada beberapa pengertian yang memerlukan penjelasan untuk
memahami bagaimana dan apa saja komponen yang ada dalam delphi, adapun
diantaranya adalah:

a. Project (*.dpr)

Project delphi adalah sekumpulan file yang akan membangun aplikasi atau
library yang dapat disebarkan kepada pemrogram lain. Pada saat memulai delphi,
delphi akan membuat sebuah project baru. Setelah itu terserah pengguna apakah
apakah ingin memodifikasi projek terasebut, membuat projek baru lagi atau
mungkin membuka projek yang sudah ada.

Project aplikasi terdiri atas :

1. File project : file ini tersimpan dengan ekstensi .dpr, hanya ada satu file

projek untuk satu projek.

2. File form : file form tersimpan dengan ekstensi .dfm, adalah file biner yang
berisi gambaran grafis dari form. Setiap file .dfm selalu pararel dengan satu
unit file yang berekstensi .pas.

3. Unit (source) : file unit tersimpan dengan ekstensi .pas, dimana setiap unit
berupa file source code dalam bahasa pascal. Tidak setiap file unit memiliki
atau terhubung file .dfm

File projek menggabung semua file diatas yang digunakan oleh delphi untuk
melakukan kompilasi dan membuat file target (.exe atau .dll).

b. Form (*.dfm)

Form merupakan tempat kita merancang program. Jika seorang pemogram
diibaratkan sebagai seorang pelukis maka form inilah yang menjadi kanvasnya.
Form yang dirancang dalam delphi bisa digunakan kembali oleh projek delphi yang
lain. Form dapat juga disimpan dalam bentuk dll, sehingga dapat digunakan oleh
aplikasi yang lain seperti c++, paradox, atau dbase. Delphi menawarkan
kemudahan pembuatan form melalui model template.



c. Unit ( *.pas)

Unit merupakan modul yang terpisah yang dapat dikompilasi tersendiri, yang
berisi deklarasi bagian publik (antarmuka) dan bagian privat (implementasi).
Setiap form dalam delphi mempunyai satu unit yang bersesuaian. Source code
unit tersimpan dengan ekstensi pas, sedangkan yang sudah terkompilasi
tersimpan dengan ekstensi .dcu. proses link akan menggabung file .dcu menjadi

satu file exe atau dll.

Tipe data

Setiap data yang disimpan di memori komputer harus memiliki tipe data.

a. Tipe Integer

Type Rentang Nilai Byte
Byte 0..255 1
Word 0..55535 2
LongWord 0..424967295 4
Shortint -:128..127 1
Smallint -32768..32767 2
Longint 2147483648 ..2147483¢6 4
Integer -2147483648..2147836414
Cardinal 0..429496729 4
Int64 _D63 2631 8
b. Tipe Real
Type Rentang Nilai Ketelitian | Byte
(digit)
Real48 2.9x103° ... 1.7 x10%8 11-12 6
Single 1.5x1045 ... 3.4 x 10%8 7-8 4
Double 50x103%4.1. 7 3% 10 15-16 8
Real 50x10324 . 1. 73%8x 10 15-16 8
Extended 3.6Xx104%51 1. 1 482 10 19-20 10
Comp _D631 el 19-20 8
Currency 922337203685477.58/19-20 8
922337203685477.5807
c. Tipe Boolean

d. Tipe Character

Tipe Byte
Boolean 1
ByteBool 1
WordBool 2
LongBool 4
Tipe Byte
Char 1
AnsiChar 1
WideChar 2




e. Tipe String

Tipe Byte Isi Maksimum
ShortString 2 sd. 256 256 karakter
AnsiString 4sd.2GB 23! karakter
WideString 4sd.2GB 239 karakter

Il. Mengenal lingkungan kerja delphi

Sebelum mempelajari ketiga struktur pemrograman ada baiknya kenali dahulu
tampilan IDE, yang merupakan editor dan tools untuk membuat program Delphi.
Pada IDE akan ditampilkan Form baru yang merupakan aplikasi/program Window
yang akan dibuat.
Tampilan interface delphi adalah sebagai berikut :

7 - o]
Fle Edt Search View Project Run Component Database Tools Window Help -] | &

SH0 At édmm In5  Colf 0x

Gambar 1.0 .Tampilan IDE delphi.

Untuk menjalankan:

1. Kliktombol Start, pilihmenuPrograms 3Borland Dephi 7 f3Delphi 7

2. Tunggu hingga program delphi aktif

3. Perhatikan komponen yang ada, diantaranya component pallete , berisi
sekumpulan objek yang akan kita gunakan dalam pembuatan program.
Kita juga dapat menambah komponen tambahan yang tidak disertakan
dalam paket delphi atau yang lebih sering dikenal dengan plugin vcl (visual
component library) eksternal.

Component Palette

Standard IAdditionaIl W’in32| Susteml Dataf-‘«ccessl [rata D:ntrolsl AD0 | InterBasel Midaz | IntemetErLlL

K OF R AWE =R e S F@=E H

Gambar 1.1.Toolbar Component Pallete.

4. Berikut ini adalah object treeview, digunakan untuk memonitoring suatu
object yang terdapat pada project yang sedang kita buat. Semua
komponen yang diletakan pada lembaran form akan terlihat di dalam object
treeview.



Dbject TreeYiew

Gambar 1.2.0bject treeview.

5. Object inspector (berisi daftar property atau sifat dari objek yang aktif yang
dapat kita ubah sesuai dengan kebutuhan dalam program kita). Kedua
objek ini merupakan komponen yang paling sering dipakai dalam
pembuatan program visual.

Object Inspectar
IFnrm‘l: TFarm LI

Froperties | Events I

Action -

ActiveCaontrol

Align alMaone
HAnchars [akLeft.akTop] —

AutoScroll True

AutoSize Falze

BiDitdode bdl eftTaRight
Barderlcon: | [biSystemtenu

BorderStyle hsSizeablz

Borderwfidth |0

Caption Pengalaman P
ClientHeight | 262 -]
|2 hidden v

Gambar 1.3. Object Inspector

6. Pada gambar dibawah ini adalah form atau lembar kerja yang digunakan
untuk meletakkan komponen.

7 Form1

Gambar 1.4. Lembar kerja form



BAB Il

Materi :
1. Instalasi zeos
2. Koneksi Delphi ke mysql dengan zeos
Maksud dan Tujuan :
1. Setelah bab ini berakhir diharapkan siswa dapat melakukan instalasi zeos di
Delphi atau komponen tambahan lainnya (additional vcl)
2. Studi kasus mengkoneksikan database mysqgl dengan menggunakan zeos

l. Instalasi Zeos

Delphi merupakan rapid programming dimana terdapat banyak komponen-
komponen add-in yang dapat ditambahkan di delphi. komponen-komponen tersebut
ada yang gratis maupun berbayar.

Zeos merupakan salah satu komponen gratisan yang digunakan sebagai
konektor untuk menghubungkan aplikasi dengan database, fasilitasnya cukup komplit
karena dapat menghandle koneksi mulai dari MySQL sampai Oracle. komponen ini
dapat didownload di http://sourceforge.net/projects/zeoslib, penggunaannya pun
sangat mudah dan tidak memerlukan banyak waktu untuk melakukan koneksi dengan
database. dalam penggunaannya, zeos tidak memerlukan ODBC (Open Database
Connectivity). Untuk masalah kehandalan, zeos dapat dikatakan cukup handal
sebagai komponen konektor database, selain itu para pengembang zeos juga masih
selalu aktif untuk melakukan perubahan- perubahan versi yang dapat dikatakan
bahwa zeos sendiri masih hidup.

Langkah —langkah instalasi zeos :

1. Ekstrak zeos dalam sebuah folder sehingga terdapat 4 folder seperti pada
gambar dibawah ini ;

x arme Size | Type Date Modified
A | Idoc File Folder S5/26/2009 12:17 AM
IJexamples File Folder S5/26J2009 12:14 AM
) packages File Folder S5/26J2009 12:14 AM

sro ile: Folder :
o File Fald SiZ6/2009 12:14 AM

Gambar 2.5. Ekstrak zeos

2. Compile semua file dibawabh ini, yang terdapat pada folder package versi
delphi 7, dengan mendouble klik :

AzCore.bpl
AzParseSq|.bpl
AzPlain.bpl
AzDbc.bpl

AZComponent.pr


http://sourceforge.net/projects/zeoslib
http://id.wikipedia.org/wiki/Open_Database_Connectivity
http://id.wikipedia.org/wiki/Open_Database_Connectivity
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Gambar 2.6. Compile package delphi

3. Setelah semua list tersebut diatas selesai dicompile, selanjutnya install
ZComponentDesign.bpl . yang terdapat pada package yang sama.

Package - ZComponentDesign.dplk

T | & &
Caompile Add  Femaove M ptions

@ ZComponentReq.... FAZEDS \archoonponent
@ ZPropertyEditor. pazF A ZEOS \archcoponent
+ Ej ZUpdateSqlEditor  FAZEOS \zrchcomponent
--[[] Fequires
] dbitl.dep
@ dezignide.dop Ehlk Instal

Gambar 2.7. Install ZComponent design

Apabila berhasil akan muncul kotak dialog yang menunjukkan bahwa
penginstallan telah selesai dijalankan seperti gambar berikut :

3 Paags O \rogras M Doran B asih P e s DAL angondar ) Lol hes bees patgiad
\!/ Mo FOlowns) tes oM@ en0(s] harvt Do sngriar o 20w Do, T OC0reacnon, TN acst T 0wy,
ot ont. TR a3 nbhenmry, Jaaent, I2Tabin, TRE s tiiecs TURE vertibivter, Tiaauavn 1 15agms.
TP adety 175NN S, TSProaRor TESAMntor, TSPvocessr TSP ooessir, 2SO TR

THoeny et 1250y ix

Gambar 2.8. Pesan instalasi zeos berhasil

4. Setelah selesai melakukan proses penginstallan, arahkan library path delphi
ke dalam direktori zeos, untuk delphi 7 dapat dilakukan dengan memilih menu
Tools->Environment Options lalu pilih tab library dan tekan tombol yang
menunjukkan library path dan akan muncul kotak diaog dan klik tombol dengan
caption *“ .. Jlalu arahkan ke direktor.i <Fol
lalu tekan OK dan klik tombol Add.

5. Selanjutnya anda dapat melihat pada toolbar komponen pallete, di tab zeos
telah terinstall :
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Gambar 2.9. Component palete zeos yang sudah terinstal

Il. Koneksi database mysqgl dengan zeos

Untuk membuat aplikasi terkoneksi dengan database, kita gunakan TZConnection
sebagai pusat koneksi dengan database. Berikut ini adalah gambar skemanya

koneksi zeos dan mysql :

} )
Konek wary
Vo
Hazd Data
<— —
J auery SGL

TZConnection TZQuery

Gambar 2.10. Skema diagram zeos
Langkah — langkah untuk mengimplementasikan koneksi :

1. Buat database dimysql dengan nama : pakar_db.

2. Restore dump file, yang berisi data dan struktur table penyakit.

3. Setelah table terpasang dalam database, klik file > new > application.

4. Siapkan komponen berikut ini kedalam form :
- ZConnectionl dan ZQuery yang terdapat pada tab zeos acces.
- Datasourcel yang terdapat pada tab data acces.
- DBGrid1 yang terdapat pada tab data controls

5. Klik komponen ZConnection dan atur propertinya pada object inspector

ebagai berikut :

User : root <atau sesuai dengan konfigurasi user MySQL anda>
Protocol - mysq|l
Port : 3306 <atau sesuai dengan konfigurasi port MySQL anda>

HostName : localhost <bisa diisi dengan IP komputer>
Database : pakar_db<contohnya>
Connected : True

=A =4 -4 -4 -8 A

Apabila Connected dapat True dan tidak ada pesan error maka selamat anda
telah berhasil mengkoneksikan aplikasi dengan MySQL dengan baik tetapi
apabila tidak maka silahkan periksa kembali settingan yang anda buat apakah

telah sesuai atau belum.

6. Klik komponen TZQuery kemudian aturlah property pada object inspector
sebagai berikut :

1 Name : QPenyakit (atau sesuai selera anda :D )

 Connecton :ZConnectionl (sesuai dengan nama yang anda buat pada

komponen TZConnection )



6. Klik komponen TDataSource ke dalam aplikasi dan set properti seperti
berikut :

T Name : dsPenyakit
I DataSet : QPenyakit

7. Lalu atur juga komponen TDBGrid set properti DataSource menjadi
dsPenyakit, untuk melakukan aksi pengaksesan kita tambahkan Button
dengan properti Name menjadi btnTampil, rancangan Formnya adalah
sebagai berikut :

— ama

Towdn

Gambar 2.11. DbGrid di form

8. Berikan kode pada event OnClick milik btnTampil sebagai berikut :

procedure  TForml.btnTampilClick(Sender: TObject);
begin
with  QPenyakit do
begin
Close;
SQL.Clear;
SQL.Text := 'SELECT * FROM penyakit ORDER BY
nm_penyakit ASC';
Open;
end;
end,

Lalu coba jalankan aplikasi dengan menekan tombol pada keyboard F9 dan apabila
telah berjalan tekan tombol Tampilkan dan apabila telah benar maka akan keluar data
pada grid yaitu sebagai berikut :

nama_penyakit definisi diagnosa penyebab A
|4 F015 Asma buruk di pagi hari (Mema) [Mema] (Mema)
| POOS Azma dengan allergen [Mema) [Mema] [Mema)
| PODZ Azma espisodik berat dan berulang [Mema) [Mema] [Mema)
| | FOO3 Aszma hipersekres [Memo) [Memo] [Memo)
FO04 Asma karena beban fisik [Memo) [Memo] [Memo)
BEGE Asma kronik £ persisten (Mema) [Mema] (Mema)
: FO14 Asma persisten pada bayi [Mema) [Mema] [Mema)
| PO09 Atelektasis [Mema) [Mema] [Mema)
| | FOD1 Bronchitis [Memo) [Memo] [Memo)
FOO7 Bronkopneumonia [Memo) [Memo] [Memo)
BESD Emfisema bulosa (Mema) [Mema] (Mema)
: P02 Empiema torasis [Mema) [Mema] [Mema)
| PODS Preurnania lobaris [Mema) [Mema] [Mema)
| | FO11 Prieumotoraks [Memo) [Memo] [Memo)
| FO0E Tuberculosis [Memo) [Memo] [Memo)
v
< >

Gambar 2.12. Hasil menampilkan data penyakit



BAB Il

Materi :
1. Manajemen file
2. Mendesain tampilan aplikasi
3. Mengenal eksepsi
Maksud dan Tujuan :
1. Setelah bab ini berakhir diharapkan siswa memanajemen file project yang
akan dibuat / didevelop agar lebih terstruktur.
2. Diharapkan mahasiswa dapat mendesain tampilan aplikasi dengan
memanfaatkan property object komponen pada object inspector.
3. Diharapkan mahasiswa dapat mengenal ekpsepsi dan mengimplementasikan
pada beberapa kasus dipemrograman.

l. Manajemen File

Dalam setiap pembuatan program delphi, saat pertama kali kita menyimpan, minimal
kita melakukan 2 kali penyimpanan. Yang pertama adalah penyimpanan Project dan
yang kedua adalah form. Untuk memastikan semua form dalam object tersimpan,
pastikan anda selalu memilih Save All. Berikut ini langkah-langkahnya:

1. Pilih menu File — Save All.

2. Isikan nama form yang akan disimpan. Catatan: Ekstensi dari form adalah pas,
dan anda tidak boleh menyimpan nama file sama dengan nama property.
Misalkan jika nama form anda adalah frmUtama, maka jika anda menyimpan
form tersebut dengan nama frmUtama juga, maka akan muncul pesan
kesalahan.

Emor

Q The project already containg a form or module named frmldtama.

] Hem |

Gambar 3.13. Jendela Pesan Kesalahan

Aturan penyeragaman penamaan :

Kaidah aturan penamaan tidak ada keharusan, namun untuk lebih mudah dalam
menyelesaikan sebuah project yang dilakukan secara team, penyeragaman
penamaan ini sangat digunakan.

No. Komponen Penamaan Contoh

1. Project Diawali prNama prPakar

2. Unit Diawali uNama uMain, uPenyakit

3. Form Diawali frmNama frmUtama, frmGejala
4. | TEdit Diawali edNama edGejala

5. | TCombobox Diawali cboNama cbPenyakit

6. TMemo Diawali meNama mePenyakit

7. | TButton Diawali btnNama btnSimpan




3. Untuk menyimpan unit, bisa menambah awalan huruf u dan dilanjutkan nama
modulasi yang sedang dibuat. Misal : uPenyakit.

Save Unit1 As

Save i |L'f} Frojects j & E-

\_;5 [C3)Epl

My Recent
Documents

@

Dreskb

esklop
My Documents

by Computer

—

File name: |uF'en5Jakiﬂ j Save |
My Metwork  Save as type: |Delphi urnit [* pas) j Cancel
Flaces
Help

Gambar 3.14. Jendela Pesan Kesalahan



Il. Mendesain tampilan aplikasi
1. Buatlah sebuah aplikasi dengan property sebagai berikut :
Nama project : prPakar
Nama form : frmMain
Nama unit  : uMain.
2. Dari tab standart component palate, klik komponen MainMenu dan letakkan
pada frmMain yang telah anda buat, seperti pada gambar dibawabh ini.

Standard I Additional | win3z |
& OF Al

Gambar 3.15. Komponen main menu

7 frmMain

Gambar 3.15. Gambar form

3. Double klik komponen MainMenu yang ada pada form sehingga muncul
cendela baru.

4. Aktifkan object inspector, kemudian ketik: &Menu pada bagian caption,
kemudian tekan tombol Enter.

object Inspector 3]
M enul -

Froperties l Eviarlis ]

Action s
AutaCheck. Falze
AutoHatkeys | maParent
AutoLineRedud maParent

Bitmap [Mone]

Break mbMone
|| Caption tMenu

Checked Falze

Default Falze

- -

Gambar 3.16. Caption pada object inspector



5. Perhatikan pada jendela disebelah kanannya. Seharusnya muncul tulisan
Menu.

Gambar 3.17. Jendela pembuatan menu

6. Selanjutnya, klik pada bagian bawah tulisan Menu, kemudian pada caption di
object inspector ketik Login (F1).

77l frmMain. MainMenu1

Login §F1)
Lagauk (F2)
Pengguna

keliar

Gambar 3.17. Menu yang telah dilengkapi

7. Ulangi langkah diatas untuk pembuatan menu selanjutnya.
Struktur menu pada gambar diatas adalah sebagai berikut :

a. Menu
1. Login (F1)
2. Logout (F2)
3. Pengguna
4. Keluar
b. Basis Pengetahuan
1. Data
1.1. Penyakit
1.2. Gejala

2. Basis Aturan
c. Diagnosa
1. Registrasi
2. Diagnosa Penyakit

d. Data
1. Pasien



2. Laporan
2.1. Pasien
2.2 Hasil Diagnosa
e. About

8. Untuk kembali keform utama anda tutup jendela pembuatan menu tadi.

lll.  Mengenal eksepsi

Eksepsi merupakan sebuah mekanisme untuk mengatasi kesalahan sewaktu program
di eksekusi. Dengan memberikan kode pada penanganan eksepsi, suatu tindakan
dapat diatur sendiri oleh pemrogram sekiranya kesalahan — kesalahan yang tidak

normal terjadi.

Delphi menyediakan dua konstruksi yang terkait dengan eksepsi, yaitu berupa :

1 tryéexanept
T tryéefinally

Bentuk umum try..except adal ah

try

pernyataan_1;
except

pernyataan_2;
end;

Pada bentuk diatas, sekiranya terjadi kesalahan pada pernyataan 1, maka yang akan
dijalankan adal ah pernyataan

pada proses menjalankan sintak query seperti dibawah ini :

function CommandSQL(Query: TQuery ; _SQL: string ; cari:

boolean;
begin
try
result:=True;
with  Query do begin
Close;
SQL.Clear;
SQL.Add(_SQL);
if cari then
Open
else
ExecSQL;
end;
except

result:=False;
end;
end;

Bentuk umum try.finally adal
try
pernyataan_1,;
finally
pernyataan_2;
end,

Pada bentuk diatas, sekiranya pada pernyataan 1 selesai dijalankan, maka
pernyataan 2 dilanjutkan. Cont oh

proses pemanggilan form seperti dibawah ini :

procedure  BukaForm(nmForm : TForm; TnmForm : TFormClass);

2.

ah

sebagai

Cont oh

Boolean):

sebagai

beri kut

pener a

beri

penerapan

k ut

tr



begin
nmForm := TnmForm.Create(Application);

try
nmForm.ShowModal;



finally
nmForm.Free;
end;
end;

Pemilihan penggunaan eksepsi tersebut diatas, disesuaikan dengan keadaan yang
dihadapi oleh pemrogram. Bila ingin meyakinkan bahwa apapun yang terjadi suatu
kode harus dieksekusi (missal pembebasan memory seperti sintak diatas), maka
gunakant r y éf.inal |y

Sedang untuk mengatur agar suatu kode dieksekusi manakala sesuatu eksepsi
terjadi, maka gunakant r y éexcept .



BAB IV

Materi :
1. Memahami struktur unit dan cara memanggil unit
2. Membuat prosedur dan fungsi

Maksud dan Tujuan :

1. Setelah bab ini berakhir diharapkan mahasiswa dapat memahami struktur
unit dan metode pemanggilan unit.

2. Diharapkan mahasiswa dapat membuat prosedur , fungsi dan menerapkan
pada aplikasi project yang dibuat.

l.  Struktur unit dan cara pemanggilan
Unit merupakan modul yang terpisah yang dapat dikompilasi tersendiri, yang
berisi deklarasi bagian publik (antarmuka) dan bagian privat (implementasi).
Setiap form dalam delphi mempunyai satu unit yang bersesuaian. Source code
unit tersimpan dengan ekstensi pas, sedangkan yang sudah terkompilasi

tersimpan dengan ekstensi .dcu. proses link akan menggabung file .dcu menjadi
satu file exe atau dll.

Urit1 ]

unit Unitl: // nams unit -

A4 awal kagian interface
interface

A daftar unit vang digunakan
uses

Windows, Messages, 3ysUtils, Variants, Classes, Graphics, Controls, Forms,
Dialogs:;

A/ deklarasi tipe data obyek
type
TForml = class|TForm)
private
{ Private declarations }
public
{ Public declarations }
end;

/4 deklarasi tambahan
rar

Farml: TForml;
A4 akhir bagian interface

A4 awal bagian implementation
implementation
(3R *.dfm}

A4 dkhir bagian implementatiod
end.

30 32 Modified Ingert \,CDde;{Diaglam-’
Gambar 4. 18. File unit aplikasi delphi

File unit terdiri dari beberapa bagian :
1. Deklarasi nama Unit yaitu Unit Unit1;
2. Interface. Bagian ini memiliki sub bagian :



3.

a Uses : mendaftarkan semua class yang diperlukan untuk membangun
aplikasi sesuai dengan komponen — komponen yang digunakan
didalam aplikasi.

b. Type : mengandung beberapa tipe data yang digunakan didalam unit.
Terdiri dari bagian Private ( hanya diakses diunit ini ) dan Public (
dapat diakses di unit lain ).

¢ Var : berisi deklarasi variable yang digunakan didalam unit.

Implementation. Kode yang ditulis dibawah kata kunci Implementation
merupakan tugas — tugas rinci yang ditangani oleh user ini.

II. Membuat procedure dan function

Function ( fungsi ) dan procedure adalah suatu rutin yang biasanya dipakai sebagai
alat untuk melakukan tugas tertentu dan atau mendapatkan nilai tertentu.
Procedure dan function juga telah disediakan oleh delphi secara otomatis tinggal
digunakan.

Sebagai contoh :

Str : procedure yang digunakan untuk mendapatkan nilai string dari data

numeric.
Contoh :
procedure  TForml.FormCreate(Sender : TObject);
Var
I : Single;
S : String;
Begin
| :=1500;
Str (1:8:2, S);
Form.caption := S;
End;

S bernilai 1500, jadi properties caption form akan tertulis 1500.

StrToCurr : function yang dipakai untuk mendapatkan nilai berupa data
numeric bertipe currency dari suatu data string. Sebagai contoh :
Contoh :

procedure  TForml.FormCreate(Sender : TObject);
Var
| : Currency;
S : String;
Begin
S := 0150006;
| := StrToCurr(S);
End;

I bernilai 1500, bertipe currency.
Latihan membuat procedure.

1.
2.

Bukalah project yang telah anda simpan.
Buat Form baru, klik File > new form
Atur properties form pada object inspector sebagai berikut :

Properti Pengaturan
Caption Data Penyakit
Nama frmPenyakit
Position Desktop Center

Selanjutnya simpanlah dalam 1 folder dimana project anda disimpan
dengan nama : uPenyakit.( menyimpan sebuah unit )

Selanjutnya, kita akan membuat sebuah procedure yang digunakan untuk
memanggil form ini dari form utama. Double klik komponen MainMenul



pada form utama (frmMain), dan klik menu Basis pengetahuan > Data >
Penyakit. Seperti pada gambar dibawah ini :

rirl frmMain.MainMenu1 EE]

Menu Basis Pengetahuan Diagnosa Data bout | |

Data Pentwakit

Basis Aturan Gejala

Gambar 4. 19. Main menu pada form utama

5. Selanjutnya, Klik tab event pada object inpector dan double klik pada event
OnClick, seperti pada gambar dibawah ini :

Object Inspector %]
FPerwakit1 -
Properties EVENSI
Action
OnddvancedD
Il onclick nyakitiClick ~ ||
OnDrawltem

Onkeasurelten
Subbdenulmage

Gambar 4. 20. Event OnClick pada Object Inspector
6. Sehingga tampil pada code editor seperti gambar dibawah ini :

E uMain.pas
b ain l

procedure TfrmMain.PenyakitlClick(3ender: Tohbject): ~
hegin

end;

end.

£

|
I
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Gambar 4. 21. Code editor pada event OnClick

7. Selanjutnya kita akan membuat procedure pemanggilan form frmPenyakit
yang telah dibuat, dengan menyisipkan kode dibawabh ini, antara begin dan
end; sebagai berikut :



frmPenyakit := TfrmPenyakit.Create(Application);
try
frmPenyakit. ShowModa  |;
finally
frmPenyakit.Free;
end;

Sehingga seperti gambar dibawah ini :

E uMain. pas
uM&n]
procedure TLrmMain.PenyakitclClick(Sender: TObiject): -
hegin
froPenyakit := TfrwPenyakit.Create (Application):
try
froPenyakit.3howlodsl:;
finally
frmPenyakit.Free:
end;
end:
end. w
£ >
113 9 todified Inzert \ Cade /i Diagram /

Gambar 4. 22. Procedure untuk menampilkan form

8. Kemudian jalankan aplikasi anda, dengan menekan F9, cobalah klik Basis
pengetahuan > Data > Penyakit. Apabila berhasil, maka form penyakit
anda akan tampil.

Latihan :
Cobalah buat procedure yang digunakan untuk menutup aplikasi. Dengan
menggunakan perintah.

Application.terminate;

Latihan membuat function.
1. Bukalah project yang telah anda simpan.
2. Buat Form baru, Kklik File > new unit, kemudian simpan unit tersebut
dengan nama uLibrary didalam satu folder dimana project anda disimpan.

E ulibrary.pas El@|g|
ubd air umewl

unit ulLibrary; ~
interface
implementation

end.

2145 Inzert \Egggf
Gambar 4. 23. unit baru




3. Dibawah kata kunci interface, tambahkan kode dibawah ini :

uses Messages, Graphics, Menus, Forms, SysUtils, Variants,
Classes, Controls,Dialogs,commctrl,StdCtrls,ExtCtrls,ComCitrls,
Dbtables,CheckLst, DB, windows ;

Kode diatas digunakan untuk memanggil class — class dari library bawaan
delphi yang terkait dengan function dan procedure yang akan Kkita
kembangkan.

4. Dibawah kode uses, kita akan membuat sebuah function dialog dengan cara
menulis pendeklarasian function sebagai berikut :

function Tanya(s : string): boolean;

Function diatas diberi nama ‘stimgohuaf” dengan
atau karakter ) dan memiliki nilai balik bertipe Boolean.

5. Kemudian penjabaran dari function yang telah dideklarasikan, ada dibawah
kata kunci implementation.

function Tanya(s : string): boolean;
begin
if MessageDlIg('Yakin anda akan '+s+' ?
", mtConfirmation,[mbYes,mbNo],0)=mrYes then
Result:= True
else
Result:= False;
end,
Selengkapnya seperti pada gambar dibawah ini :

utdain uuhaw]

unit ulLibrarvy: -
interface

uses Messages, Graphics, Menus, Forms, SysUtils, Variants, Classes, Controls,
Dimlogs, comwctrl,3tdCtrls, ExtCtrls, Comitrls, Dbtsbles,Checklst, DB, windows ;

function Tanya(s : string): boolean:
implementation

function Tanyais : string): boolean;
hegin
if MessageDlg('Takin anda akan '4s+' ? 'mwtConfirmation, [mb¥es,wbNo] ,0)=nr¥es then
Result:= True
else
Result:= Falze; |
end;

end.

17 50 M odified Insert YCode/

Gambar 4. 24. Function Tanya pada unit library

6. Pemanggilan function tersebut, double-click komponen MainMenul pada form
utama, pilih menu klik keluar seperti pada gambar dibawah ini :



7l frmMain. MainMenui

Menu Basis Pengetahuan Diagnosa Data About{
Login (F1)
Logout (F2)

Pengguna

Gambar 4. 25. Main menu pada form utama

7. Pilih Onclick tab event diobject inpector, sisipkan kode dibawah ini diantara
begin dan end;

if tanya(keluar') then Application.Terminate;

Seperti pada gambar dibawah ini :

E uMain.pas = E|E|
ubd ait l
procedure TfriMain.KeluarlClick(Zender: TChject): ~
hegin
if tanva('keluar') then Lpplication.Terminate:
end;

£

| #
|

147 1 Maodified Ihzert Y Code ,-{Diagram I

Gambar 4. 26. Methode pemanggilan function tanya

8. Jalankan aplikasi dengan menekan F9 dan cobalah klik keluar pada form menu
anda. Jika berhasil, maka akan muncul konfirmasi dialog untuk menutup
aplikasi.

\:{) Yakin anda akan keluar 7.,

[ es l [ Mo

Gambar 4. 27. Konfirmasi dialog menutup aplikasi



BAB V

Materi :
1. Studi kasus membuat pengolahan data penyakit.
Maksud dan Tujuan :
1. Setelah bab ini berakhir diharapkan mahasiswa dapat membuat validasi
form.
2. Diharapkan mahasiswa melakukan pengolahan data ( insert, update dan
delete ) dan menampilkan ( select).

Dari hasil teori dan praktek dari bab sebelumnya, sekarang kita akan mencoba
mengimplementasikan pada sebuah kasus pengolahan data penyakit. Adapun
langkah — langkahnya sebagai berikut :
1. Buat table penyakit pada database pakar_db dengan menggunakan sql tool
atau console. Struktur table sebagai berikut :

No. | Field Type Length
1. | penyakitld Tinyint 3

2. | nm_penyakit Varchar 255

3. | penyebab Varchar

4. | diagnosa Varchar

5. | pengobatan Varchar

6. | pencegahan varchar

2. Desain form seperti pada gambar dibawah ini :

7 frmPenyakit g@g|

Penyakit

edPenyebab

""" . edliagnosa

. edPencegahan

Simpan ” Batal H Hapus |

Gambar 5. 28. Tampilan form penyakit

Daftar komponen yang terdapat pada form penyakit sebagai berikut :

No. | Nama Komponen Pengaturan Properti di Object Inspector

1. Forml Name : frmPenyakit
Position : poDesktopCenter
KeyPreview : true

2. Panell Caption : Penyakit
Align : altop

3. Editl Name : edPenyakit




Memol Name : edPenyebab

Memo2 Name : edDiagnosa
Memo3 Name : edPengobatan
Memo4 Name : edPencegahan
ListViewl Name : ListData

RowSelect : True
ViewStyle : vsReport
Align : alBottom

GroupBox1 Align : alBottom

Buttonl Name : BtnOperasi, Caption : &Simpan
Button2 Name : BtnBatal , Caption : &Batal
Button3 Name : BtnHapus, Caption : &Hapus
Button4 Name : BtnTutup, Caption : &Tutup

Klik kanan pada komponen listview dan pilih colom editor, kemudian klik Addnew
list sampai 3 kali.

Atur property listindex pada object inspector sebagai berikut :

- Listindex ke -0 : width : 1

- Listindex ke -1 : width : 450, caption : Nama Penyakit.

- Listindex ke -2 : width : 430, caption : Penyebab.

7 Editing ListData.Columns %]

2

0 - TListColurnn
1 - Hama Peryakit
2 - Perwebab

Gambar 5. 29. Editing kolom pada ListData
Hasil akhir list view yang telah anda atur menjadi seperti gambar dibawah ini :

Penyakit

edPenyebab . |edPengahatan

edDiagnosa edPencegahan

Nama Penyakit FPenyebab

S | 28] [ |

Gambar 5. 30. Hasil akhir listview pada form penyakit



3. Buat DataModule, Pilih File > New > Data module. Ubah property nama
menjadi : DM pada object inspector dan simpan pada folder project anda
dengan nama uDM.

4. Kemudian dari tab component palete zeos, isikan 1 komponen ZConnectionl
dan 3 ZQuery kedalam data module yang baru saja andabuat.

7 DataModule1 E@@

)

ZConnection]

e+ [ [

Zhueryl  Z0uery?  ZQuend

Gambar 5. 31. Komponen Zeos pada data module

5. Kemudian atur property pada object inspector sebagai berikut.
Komponen Pengaturan

ZConnection Name : Koneksi
Database : pakar_db
Port : 3306

Protocol : mysq|
User : root
Connected : true
ZQueryl Connection : Koneksi
Name : Q1

ZQuery?2 Connection : Koneksi
Name : Q2

ZQuery3 Connection : Koneksi
Name : Q3

6. Setelah semua pengaturan selesai, kemudian simpan semua perubahan
dengan cara klik file > saveall.

Memulai proses koding.

1. Buatlah procedure dengan nama tampil dibawah {$R *.dfm} dengan code
sebagai berikut :

procedure  TfrmPenyakit. Tampil;
begin

CommandSQL(DM.Q2,'SELECT * FROM penyakit ORDER BY
penyakitiD DESC ', True);

ListData.ltems.Clear;

ListData.ltems.BeginUpdate;

with DM.Q2 do
begin
First;
while not eof do
begin
with  ListData.ltems.Add do
begin
Caption:= Fields[0].AsString;
Subltems.Add(Fields[1].AsString);
Subltems.Add(Fields[2].AsString);
end;
Next;

end;



end;
ListData.ltems.EndUpdate;
end;

2. Pada event form OnShow diobject inspector, tuliskan kode berikut ini :

procedure  Tfrmpenyakit.FormShow(Sender: TObject);
var i: Shortint;
begin
Caption:= judul +' - Data Penyakit';
edpenyakit.Clear;
for i:=0 to ComponentCount -1do
begin
if ComponentsJi] is TMemo then
TMemo(Components]i]).Clear;
end;
edpenyakit.SetFocus;
BtnHapus.Enabled:= False;
stsEdit = False;
id:=";
BtnOperasi.Caption :='Simpan’;
Tampil;
end;

3. Pada event form OnKeyDown, sisipkan kode berikut ini :

if Key=VK_RETURNthen
Perform(WM_NEXTDLGCTL, 0, 0);

4. Buat procedure untuk validasi penyimpanan dengan nama cekKosong :

procedure  TfrmPenyakit.cekKosong;

begin
CekNullEdit(edPenyakit,'nama penyakit');
cekNullMemo(edPenyebab, penyebab');
cekNullMemo(edDiagnosa,'diagnosa’);
cekNullMemo(edPengobatan,'pengobatan’);
cekNullMemo(edPencegahan,'pencegahan’);

end,

5. Pada event Onclick btnOperasi tuliskan kode berikut ini :

procedure  Tfrmpenyakit.BtnOperasiClick(Sender: TObject);
begin
cekKosong;
if Tanya('menyimpan') then
begin
if stskdit then
_SQL:="UPDATE penyakit SET
nm_penyakit=""+edPenyakit+",
diagnosa="'+edDiagnosa.Text+", '+
‘pengobatan=""+edPengobatan.Text+",
pencegahan=""+edPencegahan.Text+" '+
' WHERE penyakitld=""+id+"""
else
_SQL:="INSERT INTO penyakit(hm_penyakit,
diagnosa, pengobatan, pencegahan) VALUES '+

CommandSQL(DM.Q1, SQL,False);
FormShow(Self);
Berhasil('Penyimpanan sukses");
end;
end;

6. Pada tombol batal, isikan kode berikut pada event OnClick di codeinspector :



FormShow(Self);

7. Klik pada ListData, kemudian pilih tab event pada object inspector pada
event OnDoubleClick, sisipkan kode berikut ini :

procedure  Tfrmpenyakit.ListDataDbIClick(Sender:

TObject);

begin

if ListData.ltemindex <0 then exit;
Id := ListData.Selected.Caption;

CommandSQL(DM.Q3,'select * from penyakit where
penyakitID=""+id+"", True);
with  DM.Q3 do

begin
edpenyakit. Text := ListData.Selected.Subltems[0];
edPenyebab.Text := Fields[2].AsString;
edDiagnosa.Text := Fields[3].AsString;
edPengobatan.Text:= Fields[4].AsS tring;
edPencegahan.Text:= Fields[5].AsString;

end;

stsEdit := True;

BtnOperasi.Caption :='"Ubah’;
BtnHapus.Enabled = True;
end;

8. Kemudian pada komponen edPenyakit, properti event OnChange isikan kode

berikut ini :
procedure  Tfrmpenyakit.edpenyakitChange (Sender:
TObject);
begin
if  Trim(edpenyakit. Text)=" then
BtnBatal.Enabled .= False else
BtnBatal.Enabled := True;
end,

9. Event OnClick pada BtnBatal, isikan kode berikut ini :

procedure  Tfrmpenyakit.btnBatalClick(Sender: TObject);
begin

FormShow(Self);
end;

10. Kemudian pada btnHapus, isikan kode berikut ini :

procedure  Tfrmpenyakit.BtnHapusClick(Sender: TObject);
begin
if Tanya('menghapus penyakit '+edpenyakit. Text) then
CommandSQL(DM.Q1,'DELETE FROM penyakit WHERE
penyakitld=""+id+"",False);
Berhasil('Pen gahpusan sukses");
FormShow(Self);
end;

Dan pada event OnClick tombol BtnClose, isikan kode :
Close;

Jalankan program dengan menekan F9, dan cobalah memasukan data, mengedit dan
mendelete untuk testing aplikasi yang telah anda buat pada module data penyakit.

BAB VI



Materi :
1. Studi kasus membuat pengolahan data gejala penyakit.
Maksud dan Tujuan :
1. Melanjutkan dari bab sebelumnya, dan diharapkan setelah bab ini berakhir,
mahasiswa semakin mudah dan lancar dalam pengolahan data.

Lanjutkan ke modul pengolahan data gejala, sesuai dengan referensi sesuai dengan
bab sebelumnya.
1. Buat table gejala pada database pakar_db dengan menggunakan sql tool
atau console. Struktur table sebagai berikut :

No. | Field Type Length
1. gejalald Tinyint 3
2. nm_gejala varchar 255

2. Desain form seperti pada gambar dibawah ini :

7 frmGejala

Mama Gejala

swpen ||| oo

Gambar 6.32. Tampilan desain form gejala

BAB ViII



Materi :
1. Studi kasus membuat pengolahan data basis aturan
Maksud dan Tujuan :
1. Melanjutkan dari bab sebelumnya, dan diharapkan setelah bab ini berakhir,
mahasiswa semakin mudah dan lancar dalam pengolahan data.

Lanjutkan ke modul pengolahan data basis aturan, sesuai dengan referensi sesuai
dengan bab sebelumnya.
1 Buat table basisaturan pada database pakar_db dengan menggunakan sql
tool atau console. Struktur table sebagai berikut :

No. | Field Type Length
1. | penyakitld Tinyint 3
2. | gejalald Tinyint 3

2 Desain form seperti pada gambar dibawah ini :

7 frmAturan

Basis Aturan
AN
| [~
~ List Gejala
M SemAl L

Gambar 7.33. Tampilan desain form basis aturan

3. Buatlah procedure tampil pada uAturan dengan kode berikut ini :

procedure  TfrmAturan.Tampil,
begin
CommandSQL(dm.Q1,'select * from gejala’, True);
With DM.Q1 do
begin
ListGejala.ltems.Clear;



slGejala ;= TStringList.Create;

slGejala.Clear;

First;

while not Eof do

begin
ListGejala.ltems.Add(Fields[1].AsString);
slGejala.Add(Fields[0].AsString);
Next;

end;

end;
end;

Klik form, kemudian pilih event OnFormShow pada object inspector, tuliskan
kode berikut ini :

procedure  TfrmAturan.FormShow(Sender: TObject);
begin

Tampil;

cmbPenyakit.Clear;

TampilKkeCombo(cmbPenyakit,DM.Q1,'select * from

penyakit’);

Caption:= judul +' - Data Basis Aturan’;
end;

Kemudian pada combo penyakit, pilih event onchange, ketik kode berikut ini:

procedure  TfrmAturan.cmbPenyakitChange(Sender: TObject);
var
_i:Integer,;
begin
if cmbPenyakit.ltemindex= -1 then
begin
Tampil;
Exit;
end;

penyakitID:= FetchCodeCombo(cmbPenyakit. Text,1);

Tampil;

CommandSQL(DM.Q2,'select * from aturan where
penyakitID=""+penyakitID+"",True);

DM.Q2.First;
while  not (DM.Q2.Eof) do
begin
for _i:=0 to ListGejala.ltems.Count -1 do
begin
/IShowMessage(DM.Q2.Fields[1].AsString+' podo
'+slGejala[_i]);
if (DM.Q2.Fields[1].AsString=slIGejala[_i]) then
ListGejala.Checked[ _i]:= true;
end;
DM.Q2.Next;
end;
end;

Kemudian pada event OnClick BtnSimpan tulis kode berikut :

procedure  TfrmAturan.BtnOpe rasiClick(Sender: TObject);

var
jum,i : integer;

begin
jum:= ListGejala.ltems.Count -1;

CekStrings(cmbPenyakit,'Penyakit harus dipilih');



CeksStrings(ListGejala,'Gejala harus dipilih’);

CommandSQL(DM.Q1,'delete from aturan where
penyakitID=""+penyakitID+" False);

for i:k=0tojum do

begin

if ListGejala.Checked]i] then
CommandSQL(DM.Q2,'insert into aturan

values("'+penyakitID+","+slGejala[i]+")",False);

end;

Berhasil('Penyimpanan suks es");

FormShow(Self);
end,;



BAB VIl

Materi :
1. Studi kasus membuat system pelacakan penyakit
Maksud dan Tujuan :
1. Melanjutkan dari bab sebelumnya, dan diharapkan setelah bab ini berakhir,
mahasiswa dapat berekplorasi dengan teknik logika query sqgl untuk melacak
suatu penyakit pada penerapan ilmu kecerdasan buatan.

Ikuti langkah — langkah berikut ini :
1. Buat table tpenyakit dan taturan pada database pakar_db. Struktur table

sebagai berikut :
Struktur table tpenyakit :

No. | Field Type Length
1. penyakitld Tinyint 3

Struktur table taturan :

No. | Field Type Length
1. gejalald Tinyint 3

2. Desainlah tampilan form seperti pada gambar dibawah ini :

Diagnosa Penyakit ::

Pilih gejala bayi anda :

Hasil Diagnosa Penyakit :

LABELPENYAKIT

Gambar 8.33. Tampilan desain form basis aturan



Daftar komponen yang terdapat pada form konsultasi sebagai berikut :

No. | Nama Komponen Pengaturan Properti di Object Inspector
1. Forml Name : frmKonsult
Position : poDesktopCenter
KeyPreview : true
2. Panell Caption : Diagnosa Penyakit
Align : altop
3. Labell Caption : Pilih gejala bayi anda :
4. Timerl Name : timerl
5. ListViewl Name : ListData
RowSelect : True
ViewStyle : vsReport
Align : alNone
6. GroupBox1 Align : alBottom
7. Buttonl Name : BtnOperasi, Caption : &Reset
Button2 Name : BtnDetail , Caption : &Detall
Button3 Name : BtnTutup, Caption : &Tutup

3. Tambahkan pada unit Library, sebuah function dibawah ini yang digunakan
untuk mengecek keberadaan data dalam sebuah table :

function CekData(Query:TQuery; nmTabel:String):boolean;
begin
CommandSQL(Query,'select * from '+nmTabel, True);
if Query.IsEmpty the n
result := true
else
result := false;
end;

4. Tambahkan sebuah procedure pada unit library yang berfungsi untuk
mengosongkan table sebagai berikut :

procedure  KosongTabel(const Query : TQuery ; nmTabel :
String);
begin
CommandSQL(Query, TRUNCATE '+nmTabel,False);
end;

5. Kemudian pada code editor, buat procedure ViewGejala dengan sintak
sebagai berikut :

procedure  TfrmKonsult.ViewGejala;

begin
if CekData(DM.QL1, taturan ") then
_SQL:='SELECT * FROM gejala ORDER BY gejalaNama
ASC'
else

_SQL:='SELECT DISTINCT gp.gejalalD, g.gejalaNama
FROM gejala AS g, tpenyakit AS t, aturan AS gp '+
'WHERE g.gejalalD=gp.gejalalD AND
gp.penyakitID=t.penyakitiD AND gp.gejalalD NOT IN
(SELECT gejalal D FROM taturan) ORDER BY g.gejalaNama ASC

CommandSQL(DM.Q2,_SQL,True);
ListData.ltems.Clear;
ListData.ltems.BeginUpdate;



with  DM.Q2 do
begin
First;
while  noteof do
begin
with  ListData.ltems.Add do
begin
Caption:= Fields[0].AsString;
Subltems.Add(Fields[1].AsString);
end;
Next;
end;
end;
ListData.ltems.EndUpdate;
if DM.Q2.RecordCount=0 then
begin
CommandSQL(DM.Q4,'select distinct t.penyakitID,
p.penyakitNama from tpenyakit as t, penyakit as p where
t.penyakitiID=p.penyakitlD', True);
Timerl.Enabled = True;
Label3.Visible = True;
labelPenyakit.Visible := true;
labelPenyakit.Caption :=
DM.Q4.FieldByN ame('penyakitNama’).AsString;

penyakitlD:=
DM.Q4.FieldByName('penyakitID").AsString;
BtnOperasi.Enabled = True;
end;

CommandSQL(DM.Q5,'SELECT t.penyakitlD, p.penyakitNama
FROM penyakit as p, tpenyakit as t where
p.penyakitiD=t.penyakitiD ORDER BY t.penyakitlD DESC
" True);

ListViewl.ltems.Clear;

ListViewl.ltems.BeginUpdate;

with  DM.Q5 do

begin
First;
while noteof do
begin
with  ListViewl.ltems.Add do
begin
Caption:= Fields[0].AsString;
Subltems.Add(Fields[1].AsString);
end;
Next;
end;
end;
ListViewl.ltems.EndUpdate;
end;

6. Pada event OnFormShow formKonsult, tuliskan kode dibawah ini :

procedure  TfrmKonsult.FormShow(Sender: TObject);
begin
KosongTabel(DM.Q1, 'tpenyakit');
KosongTabel(DM.Q4, 'taturan’);
ViewGejala;
Labell.Caption :='Saudara '+namaPasien+' silahkan
pilih gejala bayi anda
labelPenyakit.Visible:=False;
Caption:= judul +' - Diagnosa '
BtnOperasi.Enabled := False;
end;



7. Pada event OnDoubleClick pada komponen ListData , isikan kode dibawah
ini:

procedure  TfrmKonsult.ListDataDbIClick(Sender: TObject);

var
_sl : string;

begin
if ListData.ltemIndex < 0 then exit;
gejalalD:= ListData.Selected.Caption;
if CekData(DM.Q5," taturan ') then

_SI:="SELECT penyakitID FROM aturan WHERE
gejalalD=""+gejalalD+""
else
_SI:="SELECT gp.penyakitiD FROM aturan AS gp,
tpenyakit AS t WHERE gp.penyakitID=t.penyakitiD AND
gp.gejalalD= "+gejalalD+"";

CommandSQL(DM.Q5,_sl,True);
KosongTabel(DM.Q3, tpenyakit');
with  DM.Q5 do
begin
First;
while not eof do
begin
CommandSQL(DM.Q4,'insert into tpenyakit
values("'+FieldbyName(‘penyakitID").AsString+™)",False)
Next;
end;
end;
CommandSQL(DM.Q2,'INSERT INTO taturan(gejalalD)
VALUES("+gejalalD+")',False);
ListData.Clear,;
ViewGejala;
end;

8. Pada event onClick tombol btnReset, isikan kode : FormShow(Self);

9. Pada event onclick BtnDetail, digunakan untuk mencetak laporan hasil
diagnosa. Cara membuat laporan akan dibahas pada bab selanjutnya.



BAB IX

Materi :
1. Studi kasus membuat laporan data penyakit
Maksud dan Tujuan :

1. Setelah bab ini berakhir, mahasiswa dapat membuat laporan dengan
component Quick Report.

Langkah-langkah membuat laporan adalah sebagai berikut :
1. Buat sebuah form yang diberi nama pada frmLaporan.
2. Letakkan komponen QuickRepl pada form, seperti pada gambar dibawah ini.

7 frmLaporan EHE‘E

............................................................................ ~
[ L]

v

< k3

Gambar 9.34. Tampilan desain form laporan

3. Atur properti QuickRepl pada object inspector, sebagai berikut :

- DataSet :DM.Q1
- DetailBand s true
- PageFooterBand  : true
- TitleBand s true

4. Kemudian desain tampilan laporan seperti pada gambar dibawah ini, dengan
menggunakan QRLabel yang ada pada tab Qreport component palete :

Yl frmLaporan E‘ @| E|
r 1 : 3 A" 5 3 T 5 0
SISTEM PAKAR

! Diagnosa Penyakit
Dicetal Toi{Date]
:i)enyakitNamﬁ
R Th ................. 1 1 A [ P S S &
: Penvebab : il Ibiaanosa :
3
4
Pengobah\n : ?encegahan :
i ’
H
b
< >

Gambar 9.35. Tampilan desain form laporan



5. Buka kembali frmKonsult, pada OnClick BtnDetail, isikan kode berikut ini :

procedure  TfrmKonsult.BtnOperasiClick(Sender: TObject);
begin

CommandSQL(DM.Q2,'insert into
hasil_konsultasi(penyakitlD,kd_pasien,tgl_konsultasi)

);
CommandSQL(DM.Q1,'select * from penyakit where
penyakitlD=""+penyakitID+"", True);
frmLaporan := TfrmLaporan.Create(Application);
try
frmLaporan.QuickRep2.Preview;
finally
frmLaporan.Free;
end;
end;

Latihan
Buatlah laporan seluruh data penyakit dan laporan seluruh data gejala



BAB X

Materi :
1. Pengaturan otoritas untuk mengakses ke sistem

Maksud dan Tujuan :
1. Setelah bab ini berakhir, mahasiswa dapat membuat proses login dan logout
pada sebuah system aplikasi.

Langkah — langkah sebagai berikut :
1. Buat procedure yang digunakan untuk menonaktifkan menu sebelum proses
login. Procedure tersebut beri nama Session dengan parameter bertipe
Boolean. Pastikan pada unit utama, sisipkan kode berikut ini :

procedure  TfrmMain.Session(Login:Boolean);

begin
if Login then
begin
Loginl.Visible = not login;
Logoutl.Visible = login;
PengPeny.Visible .= login;

BasisAturanl.Visible := login;

Penggunal.Visible := Login;
IdentifikasiPenyakitl.Visible:= not Login;
Laporanl.Visible = Login;

end else

begin
Loginl.Visible = not login;
Penggunal.Visible := Login;
Logoutl.Visible = login;
PengPeny.Visible = login;
BasisAturanl.Visible := login;
IdentifikasiPenyakitl.Visible:= not Login;
Laporanl.Visible := Login;

end,;

end;

2. Buatlah form baru dengan nama frmLogin, seperti pada gambar dibawah ini:

F frmLogin

Gambar 10.36. Tampilan desain form login



Daftar komponen yang terdapat pada form login sebagai berikut :

No. | Nama Komponen Pengaturan Properti di Object Inspector
1. Forml Name : frmLogin
Position : poDesktopCenter
KeyPreview : true
2. Panell Caption : Login
Align : altop
3. Labell Caption : User Name :
4, Label2 Caption : Password :
5. Editl Name : edUser
Edit2 Name : edPassword dan PasswordChar : *
6. Buttonl Name : BtnLogin, Caption : &Login
Button2 Name : BtnBatal , Caption : &Batal

3. Pada event OnChange edPassword, isikan kode berikut ini :

procedure  TfrmLogin.edPasswordChange(Sender: TObject);
begin
CommandSQL(dm.Q1,'select * from pengguna where
userName=""+edUser.Text+" and
userPassword=""+Enkripsi(edPassword.Text)+" ",true);
if DM.QLl.IsEmpty then
BtnOperasi.Enabled:= False
else
begin
BtnOperasi.Enabled:= true;
BtnOperasi.SetFocus;
end;
end;



BAB Xl

Materi :
1. Membuat file setup

Maksud dan Tujuan :
1. Setelah bab ini berakhir, mahasiswa dapat membuat aplikasi yang telah di
develop menjadi file setup ( file instalasi ).

Program aplikasi siap pakai, tidak berbentuk excutable dari hasil kompilasi, namun
berupa file setup yang nantinya akan diinstal pada system operasi. Pada bab ini,
pembuatan file setup dengan menggunakan aplikasi bawaan delphi dengan nama
InstallShield.
1. Kilik start -> Program -> InstallShield -> Express. Sehingga muncul tampilan
seperti dibawah ini :

™ InstallShield Express Borland Limited Edition

” Fle Edt View Go Project Buld Tools Help ‘

EEEEIEEE TS A

¥ InstallShield Today

Installzhield Taday Tuesday, Octaber 6, 2003
Help Select a project type, provide a new project name and lacation (or sccept the default), select

* Welcome a project language, and dick Create ko create a new project,

WWelcome to InstallShield Project Type:

Q Create a new project... @ @ Create

Create a project of the selected type

Blark Setup
Project
Open a project...
& Open an existing projeck of browse to
locate a project

@ InstallShield Services

iaccess Suppork services and Resources
Description:
The Project wizard guides you step-by-step through creating & basic setup praject

Project Name and Location:

[ci\pocuments and Settingstwahyuity DocumentsitySetups) Your Project Mame-1.ism
Browse. ..

Project Language:

[Erlish (united States) |
!
L
sy 1 )

Gambar 11.36. Halaman depan installshield

2. Kilik project wizard, pada project type, kemudian klik create sehingga muncul
tampilan seperti dibawah ini.

Project Wizand [‘S_<|

Welcome to the Project Wizard

If your setup needs ko be up and running quickly, the Project
wizard is a great place to skart. In just a few minutes you can
create a fully Functional setup that performs File transfer,
creates shorbouts, and provides registry data For vour
application.

< Back Cancel | Help |

Gambar 11.37. Tampilan selamat datang



3. Klik next, isikan create a new project dengan nama project anda ( misal :
pakar ).

Project Wizand

Wizard Project -"-_\ n
Identify a project For the Project Wizard A =

Create a new project, open a recent project, or browse ko open another existing project.
Projects created with the Project wizard may be subseguently opened and customized in the
Installshield IDE. Similarly, projects created with the Project wizard can be opened again using
the wizard and modified.

% Create a MNew Project

I pakar]

Project Language: | English {United States) ;I
[ Open a Recent Projeck:

| [

i Open an Existing Projeck:

| al
« Back, I Mext = I Cancel | Help |

Gambar 11.38 Tampilan create new project

4. Klik next, isikan nama aplikasi, versi, dan default destination seperti pada
gambar dibawah ini :

Project Wizard

Application Information "._‘ N
Provide descriptive information about vour application A =

Flease provide the requested information. Click a field For additional help.
Application Mame:

| pakar

Application Yersion:

[1.0

Default Destination Folder:

I [ProgramFilesFolder Jwabyusoftpakar

Enter the default destination Folder where your application's Files will be copied to. Use square
brackets to specify a Windows Installer Folder property, The path entered here will be used to
set the walue For INSTALLDIR, which is the default destination Folder For all of your setup's
features and components.,

= Back I Mext = I Cancel Help

Gambar 11.39. Halaman setup informasi aplikasi anda



5. Kilik next, kemudian unchecked pada automatic update.

Project Wizand

Software Updates "._\ .
Provide wour customers automatic software updates, X =

Installshield enables vou to sutomatically deliver software updates ko wour customers by
incorporating the Update Service inko wour setup, The Update Service notifies your customers
of available updates and seamlessly downloads and installs the updates,

r Enable wour produck to receive updates via the
Installshield Update Service.

YWisit the [nstallShield Web site For more information on the Update Service

= Back I [ext = I Cancel Help

Gambar 11.40. konfirmasi auto update software installshield

6. Klik next, isikan nama perusahaan anda, nomor telephone dan website.
Keterangan ini bersifat opsional, jika belum punya perusahaan, dapat anda
lewati.

Project Wizard

Company Information "-.E N
Prowide descriptive infarmation about wour company A =

Please provide the requested infarmation. Click a Field For additional help.

Company Mame:

Help Telephone Mumber:
| 1-555-555-4505

URL For Company of Product Infarmation:

I btk e yourcomparry, com

Entet wour company name in the edit field. This walue will be used to identify your company as
the publishet of this application in the end uset's registry,

= Back I Mext = I Cancel Help

Gambar 11.41. Informasi perusahaan



7. Kemudian muncul tampilan seperti pada gambar dibawah ini, selanjutnya klik
next :

Project Wizard

Application Features ' \
Identify the application Features you want exposed ko your customers

Click &dd or Delete to build an application Features list,

Features allow wou to split vour application into individually installable sets. You must have at
lzast one Feature in vour installation. IF vou deliver more than one Feature, vou can display a
Custam Setup dialog during installation which will allove wour customers ko select which features
ko install,

o

Delete

Renarme

JIE

Destination Eolder: [[INSTALLDIR]

= Back I Mexk = I Cancel I Help |

Gambar 11.42. Halaman fitur aplikasi.

8. Klik next, kemudian klik add files , kemudian buka file excutable project anda
dan sertakan lib mysql.dll

Project Wizard

Application Files ."-__' \
Associate files with Features A =
Click the Add Files button or drag and drop files from Explorer onto the File list below to add
files to the feature selected in the feature combo box,
I.ﬁ.lwa\,fs Irskall ;I
| Hame | Size | Link To
ﬁprSispak.exe 1.51 ME E:\Pakar
libresql . dll 1.24 ME  C:\Program File.. . Delete Files |
Propetties. .. |
S -
< Back Mexk = Cancel Help

Gambar 11.43. Gambar file yang akan di built



9. Lanjutkan klik next, kemudian muncul tampilan dibawah ini :

Project Wizard

Create Shortcuts "‘.,\ N
Define shorkouts which will be created during installation " =X

Specify the Following information For each shortout vou want ko create,

o Target

Tasar I ;I

=il start Menu
: Programs Menu Leen
Skartup I il
Send To

... f5] Deskiop

Tcon Indesx

< Back I Mt = I Cancel Help

Gambar 11.44. Gambar setup shortcuts

10. Lanjutkan klik next, sehingga muncul tampilan dibawah ini :

Project Wizard

Registry Data ."-_\ N
Import a RE file inko & Feature's reqgistry data \ =

Select a feature and specify a registry {.reg) file which Installshield will merge wikh the
feature's reqgistry data. The registey entries will be writken to the target syskem when the
feature is installed.

Features

REG File

< Back I Mext = I Cancel Help

Gambar 11.45. Gambar registrasi data



11. Lanjutkan klik next, sehingga muncul tampilan dibawah ini :

Project Wizard

Dialogs "‘-._\ \
Zreate the setup user interface \ .

In the dialogs list below, identify which dialogs vwou want to display during installation by
selecting the check box next to the dialog name.

LI Aq : M
= Customer Information Tmm—— :
Ready To Instal
= [t bt e e e
<_ |
Help

Gambar 11.45. Gambar dialog box instalasi

12. Lanjutkan klik next, sehingga muncul tampilan dibawah ini :

Project Wizand

Wizard Summary "-__‘ 1
Rewview a summaty of wizard settings \ =X

Project Information

Project Mame: C:i\Documents and Settingsiwahby iy DocumentsiySetupsipakar,ism
Application Information

Application Mame: pakar

Cormpany Mame: Your Company Mame

Destination Foldet: [ProgramFilesFalder Jwahyusoftipakar
Setup Design

Feature: Always Install

< Back I Finish I Cancel Help

Gambar 11.46. Proses siap build



12.Kilik finish, maka proses build setup.exe dijalankan. Setelah muncul konfirmasi
sukses seperti pada gambar dibawa ini, maka proses telah selesai.

™ pakar - InstallShield Express Borland Limited Edition _||E|g|
JJ File Edit wiew Go Project Build Tools Help |
|xos@a|B@E| v & N e
1. 0rganize Your Setup
InstallShisld Today wll Organize Your Setup
i Help
Organize Your Setup " o |
e General Information The first step in building anything is to lay a solid foundation, The base of your
C% Features setup is formed by specifying application inforrmation through the General
Zil setup Types Information view and creating features in the Features view, Fesdback
EH Upgrade Paths
- o Specify Application Data ’ General Information
P S —
< - N o
Zl[Dialog SetupResume for language English (United States) built ~
|pialog SetupType for language English (United States) built B
Dizlog SplashBitmap for language English {United States) builk
F.esolving strings. ..
Language English {United States) builk
Building CAE files. ..
Datal.cab builk
File:s built
Media table successFully built
Setup.exe created
E:xpressiSingleImage build completed with 0 errors, 0 warnings ]
JReady [ [ /A

Gambar 11.47. Konfirmasi selesai

Mencoba Proses Instalasi

Setelah berhasil membuat instalasi, sekarang kita coba file setup yang telah anda

buat.
1. Buka setup pada direktori Disk 1, pada destination instalasi yang anda buat

seperti pada gambar dibawabh ini :

File Edit View Favorites Tools Help
@Back - J 1’ /j" Search v Lg = Sl x @ LCJ Dlj [\/

Address i\{j C:\Documents and SettingsiwahyulMy DocumentsiMySetupsipakar|Express\SingleImage\DiskImages\DISK1

X
Folders s
@ Deskkop A Setup Launcher
= = Your C !
= ({2 My Documents o MR R

# () CyberLink
() My eBooks
<ﬂ My Music
1@} My Pictures
= £ MySetups
| Dialoas
[ MergeModules
= ) pakar
= ) Express
() Interm
1= ) SingleImage
= () DiskImages
(=)
[ LogFiles
() Reports
1) Templates

u: Folders

Gambar 11.48. Letak file setup



2. Klik next, jika berhasil akan muncul seperti pada gambar dibawabh ini :

{15 pakar - InstaliShield Wizard X

Welcome to the InstallShield Wizard for pakar

The InstallShield{R) Wizard will install pakar on your computer.
To continue, click Mext,

WARNING: This program is protected by copyright law and
international treaties.

Back [ Next> [ Cancel ]

Gambar 11.49. Halaman awal instaler

Lanjutkan Kklik next, pilih accept pada license agreement. Seperti pada
gambar dibawah ini :

i pakar - InstallShield Wizard

License Agreement

Flease read the following license agreement carefully,

Ta add your own license text ta this dialog, specify your license agreement file in the Dialog
editar,

Mavigate to the User Interface view,

Select the LicenseAgreement dialog.

Choose ko edit the dialog layout.

onee in the Dialog editor, select the Memo ScrollableText control,
Sef FileMame ko the name of your license agresment RTF File,

[

iafter you build vour release, vour license text will be displayed in the License Agreement dialog,

()1 do not accept the berms in the license agreement

Installshield

[ < Back ” Mext > ] [ Cancel ]

Gambar 11.50. Halaman persetujuan lisensi
Lanjutkan klik next sehingga muncul seperti gambar dibawah ini :

%5 pakar - InstallShield Wizard

Customer Information

Flease enter your information.

User Mame:

Qrganization:

WTecnology

Install this application For:
(3) Anyone who uses this computer (all users)
(C)0nly For me (Wahyu Widodo)

Installshield

[ < Back ” Mext = ] [ Cancel ]

Gambar 11.51. Halaman customer information



5. Lanjutkan klik next, sehingga muncul seperti gambar dibawah ini :

i% pakar - InstallShield Wizard

Setup Type

Choose the setup bype that best suits your needs,

Flease select a setup type,

G
Al program Features will be installed, {Requires the most disk.
space. )
() Minimal
@ Mirimurm required Features will be installed,
() Custom

Choose which program Features you want installed and where they
will be installed, Recommended For advanced users,

Inistallshield

[ < Back “ Mext = ] [ Cancel

Gambar 11.52. Halaman tipe setup

6. Lanjutkan Kklik next, sehingga muncul seperti gambar dibawah ini :

i pakar - InstallShield Wizard

Ready to Install the Program

The wizard is ready to beqgin installation,

If you want ko review or change any of wour installation settings, click Back, Click Cancel ko
exit the wizard,

Current Setkings:

Setup Type:
Typical

Deskination Folder:

Ci\Program Filesiwahyusoftipakary

User Information:
Mame: W ahyu Widodo
Company: WTecnology

InstallShield

[ <Back || Install i [ Cancel

Gambar 11.53. Proses siap install

7. Klik install, tunggu proses dan Klik finish. Selanjutnya cek hasil instalasi pada
start->program files. Jika ada, berarti program telah berhasil dipasang.



